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About This Document
This document provides information to install and use Release 5.5.

Audience
These release notes are for the personwho installs the product and for anyone using the product
following installation.

Organization
This document is organized as follows:

Provides overviews of the Server 2003 Enterprise and Datacenter editions and supported
configurations. It also lists changes in the this release, additional software requirements,
supported components, and issues youmay encounter, withworkaroundswhen available.

Chapter 1 (page 11)

Provides Information about installing the Windows® Server 2003 software.Chapter 2 (page 41)

Lists the documentation available for HP Integrity servers runningWindows Server 2003
and helps you find the system firmware, drivers, and utilities applicable to Windows
Server 2003.

Chapter 3 (page 45)

Typographic Conventions
This document uses the following typographical conventions:
Command A command name or qualified command phrase.
Computer output Text displayed by the computer.
Ctrl+x Akey sequence. A sequence such asCtrl+x indicates that youmust hold

down the key labeledCtrlwhile you press another key ormouse button.
Key The name of a keyboard key. Return and Enter both refer to the same

key.
User input Commands and other text that you type.

HP Encourages Your Comments
HP encourages your comments concerning this document. We are committed to providing
documentation that meets your needs. Send any errors found, suggestions for improvement, or
compliments to:
feedback@fc.hp.com
Include the document title, manufacturing part number, and any comment, error found, or
suggestion for improvement you have concerning this document.

Typographic Conventions 9
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1 Release 5.5 Overview
This chapter provides the following information:
• An overview of the Server 2003 Enterprise and Datacenter editions and supported

configurations
• Changes introduced in Release 5.5
• Software requirements
• Supported components
• Troubleshooting common issues

System Configurations
Microsoft® Windows® Server 2003, Enterprise Edition may be licensed for up to 8 processors,
and Datacenter Edition may be licensed for up to 64 processors. A processor can contain one or
multiple cores, and each core can be multi-threaded.
Enterprise Edition and Datacenter Edition configurations may include:
• HP Super-Scalable Processor Chipsets (sx1000 and sx2000)
• HP mx2 dual-processor modules, with Intel® Itanium® processors
• Intel Itanium processors
• Intel Dual Core Itanium processors
HP Integrity servers running Microsoft Windows Server 2003 deliver high performance, great
flexibility, and simplifiedmanagementwith exceptional value, and include the followingmodels
and feature sets.

FeaturesModel

• 2-64 Itanium processors with the HP mx2 dual processor module in one cabinet, 2-64
Itanium processors in two cabinets, or 2-64 Intel Dual Core Itanium processors in two
cabinets

• 1 TB memory capacity with SX1000
• 2 TB memory capacity with SX2000
• Up to 8 hardware partitions (nPartitions) per cabinet
• 96 Hot-plug PCI-X slots (Up to 192 slots with I/O Expansion Cabinets)

Superdome
(sx1000 and sx2000
chipsets)

• 2-32 Itaniumprocessorswith theHPmx2dual-processormodule, 2-16 Itaniumprocessors,
or 2-16 Intel Dual Core Itanium processors

• 256 GB memory capacity
• Up to 4 hardware partitions (nPartitions) with a Server Expansion Unit
• 16 hot-plug PCI-X slots (up to 32 with optional Server Expansion Unit)
• One 1-Gb LAN port

rx8620 and rx8640

• 2-16 Itaniumprocessorswith theHPmx2 dual processormodule, 2-8 Itaniumprocessors,
or 2-8 Intel Dual Core Itanium processors

• 128 GB memory capacity
• Up to 2 hardware partitions (nPartitions)
• 15 Hot-plug PCI-X slots
• One 1-Gb LAN port

rx7620 and rx7640

System Configurations 11



FeaturesModel

• 1-4 processors
• 192 GB memory capacity
• 8 PCI-X slots or 4 PCI-Express x8 slots and 4 PCI-X slots
• Two 1-Gb LAN ports
• vMedia
• vKVM support
• Hyper-threading support
• zx2 chipset

rx6600

• 1-4 processors
• 128 GB memory capacity
• 6 PCI-X slots
• Two 1-Gb LAN ports

rx4640

• 1-2 processors
• 96 GB memory capacity
• 8 PCI-X slots or 4 PCI-Express x8 slots and 4 PCI-X slots
• Two 1-Gb LAN ports
• Hyper-threading support
• zx2 chipset
• vMedia
• vKVM support

rx3600

• 1-2 processors
• 32 GB memory capacity
• 1 PCI-X slot
• zx2 chipset
• 2 PCI-Express slots
• Hyper-threading support
• Two 1-Gb LAN ports
• vMedia
• vKVM support

rx2660

• 1-2 processors
• 32 GB memory capacity
• 4 PCI-X slots
• Two 1-Gb LAN ports

rx2620

• 1-2 processors
• 16 GB memory capacity
• 2 PCI-X slots
• Two 1-Gb LAN ports

rx1620

• 1-2 processors
• 48 GB memory capacity
• 3 Mezzanine slots (2 Type II PCIe x8, 1 Type I PCIe x4)
• 4 GB LAN ports; 1 iLO 2 management LAN port

BL860c and BL870c
Server Blade

NOTE: Each HP mx2 dual processor module is equal to two processors. The HP mx2 dual
processor module is supported by the sx1000 chipset used in the rx8620, rx7620, rx4640, and
Superdome with sx1000. The Intel Dual Core Itanium processor is supported by the sx2000
chipset used in the rx8640, rx7640, and Superdome sx2000.
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What’s New in Windows Solution 5.5
This release adds several new features, enhancements, and defect fixes to theWindows Integrity
solution. Here are some of the highlights:
• Support for HP Integrity BL870c blade servers with the following features:

— Dual-Core Intel® Itanium® 9100 series processors, 4 sockets
◦ 1.4 GHz/12 MB, 533 FSB, 100W
◦ 1.6 GHz/18 MB, 533 FSB, 100W
◦ 1.6 GHz/24 MB, 533 FSB, 100W

— Industry standard DDR2-SDRAMwith 24 total DIMM slots
— Serial Attached SCSI (SAS) drives, 3 x 2.5-inch single form factor (2 for mirrored disks

with 1 spare)
— Three public mezzanine slots for I/O cards

• Additional support for the following on HP Integrity BL860c and BL870c blade servers:
— C3000 enclosure with OA 2.1
— Microsoft clusters
— vFloppy and vFlash functionality
— New I/O device: 447883-B21 PCI Express quad-port Gigabit mezzanine card

• Software enhancements:
— HP Smart Update Manager (HP-SUM) replaces Remote Deployment Utility (RDU)

• Support for the MSA60/MSA70 SAS/SATA storage connected to the Smart Array P600
(requires firmware level 1.98 or higher)

• Support for SAS clustering
• Various documentation updates.
• Various defect fixes.

Software Requirements
In addition to the software included from HP, the following software is required.

Web Browser
The browser-based interface to the HP Smart Setup and Smart Update CDs requires Internet
Explorer version 5.1 or higher. The latest version of Internet Explorer is available from the
Microsoft download site at http://www.microsoft.com/windows/ie/default.mspx.

TCP/IP and SNMP
HP Insight Management Agents require installation and configuration of TCP/IP and SNMP.
Youmust install SNMPmanually. If necessary, see theMicrosoft Knowledge Base article #324263,
How to Configure the Simple Network Management Protocol (SNMP) Service in Windows Server 2003
at http://support.microsoft.com/?kbid=324263.

Utility Meter
Pay Per Use (PPU) 7.1 software requires Utility Meter software version 7.3 or higher.

Supported Components
The following tables list the components that are supported on each server:

What’s New in Windows Solution 5.5 13
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Superdome (with sx1000 or sx2000 chipset)
Table 1-1 Components supported with Superdome sx1000 or sx2000

• Windows Server 2003, Enterprise Edition with SP1/SP2 for Itanium-based Systems
• Windows Server 2003, Datacenter Edition with SP1/SP2 for Itanium-based Systems

Operating System

• HP PCI 1000 Base-T Gigabit Ethernet adapter for Windows (A7061A)
• HP PCI 1000 Base-SX Gigabit Ethernet adapter for Windows (A7073A)
• HP PCI-X Dual Port Gigabit Ethernet SX adapter (A9899A)
• HP PCI-X Dual Port Gigabit Ethernet TX adapter (A9900A)
• HP PCI-X Windows/Linux 10 Gigabit Ethernet (AD144A)
• HP PCIe Gigabit Ethernet adapter SX 2P (AD338A)
• HP PCIe Gigabit Ethernet adapter TX 2P (AD337A)

LAN Adapter

• HP PCI Single Channel Ultra160 SCSI Adapter for Windows (A7059A)
• HP PCI Dual Channel Ultra160 SCSI Adapter for Windows (A7060A)
• HP PCI-X Dual Channel Ultra320 SCSI Host Bus Adapter (A7173A)

SCSI Adapter

• HP StorageWorks 2 Gb Fibre Channel HBA (AB232A)
• HP StorageWorks 2 Gb, 64-Bit/133MHz PCI-X-to-Fibre Dual Channel HBA (AB466A)
• HP StorageWorks 2Gb, 64-Bit/133MHzPCI-X-to-Fibre Single ChannelHBA (AB467A)
• HP StorageWorks 4 Gb Single Port 64-bit 266 MHz Fibre Channel HBA (AB429A)

(Superdome sx2000 only)
• HP StorageWorks 4 Gb Dual Port 64-bit 266 MHz Fibre Channel HBA (AB379A)

(Superdome sx2000 only)
• HP StorageWorks 4 Gb Dual Port 64-bit 266 MHz Fibre Channel HBA (AB379B)

(Superdome sx2000 only)
• HP StorageWorks 4 Gb Single Port 64-bit 266 MHz Fibre Channel HBA (AD167A)
• HP StorageWorks 4 Gb Dual Port 64-bit 266 MHz Fibre Channel HBA (AD168A)
• HP StorageWorks FC2142 PCIe Single Port 4 Gb Fibre Channel adapter (A8002A)
• HP StorageWorks FC2242 PCIe Dual Port 4 Gb Fibre Channel adapter (A8003A)
• HP StorageWorks FC1142 PCIe Single Port 4 Gb Fibre Channel adapter (AE311A)
• HP StorageWorks AD300A PCIe Dual Port 4 Gb Fibre Channel adapter (AD300A)

Fibre Channel Adapter

• HP PCI-X Dual Channel Smart Array 6402, Ultra320 SCSI (A9890A)
• HP PCI-X 4-Channel Smart Array 6404, Ultra320 SCSI (A9891A)
• HP PCI-X Single Channel Smart Array P600, SAS 3.0 (337972-B21) (consists of two

MSA50 storage enclosures attached in series)
• HP PCIe Smart Array P800, SAS (AD335A)
• HP PCIe Smart Array E500, SAS (AH226A)

RAID Controller

• HP USB/VGA card (A6869A) (in the I/O chassis, attached to the root cell only)
(supported in Superdome with sx1000 chipset only)

• HP USB/VGA card (A6869B) (in the I/O chassis, attached to the root cell only)
(supported in all Superdome)

VGA Graphics

• Only HP keyboards are supported.Keyboard
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NOTE: The Superdome sx2000 server supports two Fibre Channel Adapters not currently
supported by the other Superdome computers, the AB429A and AB379A described in the Fibre
Channel Adapter section of the table.

rx8640
Table 1-2 Components supported with rx8640

• Windows Server 2003, Enterprise Edition with SP1/SP2 for Itanium-based Systems
• Windows Server 2003, Datacenter Edition with SP1/SP2 for Itanium-based Systems

Operating System

• HP PCI 1000Base-T Gigabit Ethernet Adapter for Windows (A7061A)
• HP PCI 1000Base-SX Gigabit Ethernet Adapter for Windows (A7073A)
• HP PCI-X Dual Port Gigabit Ethernet SX adapter (A9899A)
• HP PCI-X Dual Port Gigabit Ethernet TX adapter (A9900A)
• HP PCIe Gigabit Ethernet adapter SX 2P (AD338A)
• HP PCIe Gigabit Ethernet adapter TX 2P (AD337A)
• HP PCI-X Windows/Linux 10 GigE (AD144A)

LAN Adapter

• HP PCI Ultra160 SCSI Adapter for Windows (A7059A)
• HP PCI Dual Channel Ultra160 SCSI Adapter for Windows (A7060A)
• HPPCI-XDual Channel Ultra320 SCSIHost BusAdapter (A7173A) (supported as accessory

card and as embedded core I/O)

SCSI Adapter

• HP StorageWorks 2 Gb Fibre Channel HBA (AB232A)
• HP StorageWorks 2 Gb, 64-Bit/133 MHz PCI-X-to-Fibre Dual Channel HBA (AB466A)
• HP StorageWorks 2 Gb, 64-Bit/133 MHz PCI-X-to-Fibre Single Channel HBA (AB467A)
• HP StorageWorks 4 Gb Single Port 64-bit 266 MHz Fibre Channel HBA (AB429A)
• HP StorageWorks 4 Gb Dual Port 64-bit 266 MHz Fibre Channel HBA (AB379A)
• HP StorageWorks 4 Gb Dual Port 64-bit 266 MHz Fibre Channel HBA (AB379B)
• HP StorageWorks 4 Gb Single Port Fibre Channel HBA (AD167A)
• HP StorageWorks 4 Gb Dual Port Fibre Channel HBA (AD168A)
• HP StorageWorks FC2142 PCIe Single Port 4 Gb Fibre Channel adapter (A8002A)
• HP StorageWorks FC2242 PCIe Dual Port 4 Gb Fibre Channel adapter (A8003A)
• HP StorageWorks FC1142 PCIe Single Port 4 Gb Fibre Channel adapter (AE311A)
• HP StorageWorks AD300A PCIe Dual Port 4 Gb Fibre Channel adapter (AD300A)

Fibre Channel
Adapter

• HP PCI-X Dual Channel Smart Array 6402, Ultra320 SCSI (A9890A)
• HP PCI-X 4-Channel Smart Array 6404, Ultra320 SCSI (A9891A)
• HP PCI-X Single Channel Smart Array P600, SAS 3.0 (337972-B21) (consists of twoMSA50

storage enclosures attached in series)
• HP PCIe Smart Array P800, SAS (AD335A)
• HP PCIe Smart Array E500, SAS (AH226A)

RAID Controller

• HP USB/VGA card (A6869B) (in the I/O chassis, attached to the root cell only) (supported
in both rx8620 and rx8640)

VGA Graphics
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NOTE: The rx8640 server supports multiple SA64xx cards connected to internal drives for
either boot or for data. For example, one slot may hold a SA64xx card connected to two internal
drives for boot, and another slot may hold a SA64xx card connected to two internal drives for
data. Or, each card may be connected to two internal drives for data.

rx8620
Table 1-3 Components supported with rx8620

• Windows Server 2003, Enterprise Edition with SP1/SP2 for Itanium-based Systems
• Windows Server 2003, Datacenter Edition with SP1/SP2 for Itanium-based Systems

Operating System

• HP PCI 1000Base-T Gigabit Ethernet Adapter for Windows (A7061A)
• HP PCI 1000Base-SX Gigabit Ethernet Adapter for Windows (A7073A)
• HP PCI-X Dual Port Gigabit Ethernet SX adapter (A9899A)
• HP PCI-X Dual Port Gigabit Ethernet TX adapter (A9900A)
• HP PCI-X Windows/Linux 10 GigE (AD144A)

LAN Adapter

• HP PCI Ultra160 SCSI Adapter for Windows (A7059A) (supported as accessory card and
as embedded core I/O)

• HP PCI Dual Channel Ultra160 SCSI Adapter for Windows (A7060A)
(supported as accessory card and as embedded core I/O)

• HP PCI-X Dual Channel Ultra320 SCSI Host Bus Adapter (A7173A)

SCSI Adapter

• HP StorageWorks 2 Gb Fibre Channel HBA (AB232A)
• HP StorageWorks 2 Gb, 64-Bit/133 MHz PCI-X-to-Fibre Dual Channel HBA (AB466A)
• HP StorageWorks 2 Gb, 64-Bit/133 MHz PCI-X-to-Fibre Single Channel HBA (AB467A)
• HP StorageWorks 4 Gb Single Port Fibre Channel HBA (AD167A)
• HP StorageWorks 4 Gb Dual Port Fibre Channel HBA (AD168A)

Fibre Channel
Adapter

• HP Dual Channel Smart Array 5302, Ultra160 SCSI (A9825A)
• HP 4-Channel Smart Array 5304, Ultra160 SCSI (A9826A)
• HP PCI-X Dual Channel Smart Array 6402, Ultra320 SCSI (A9890A)
• HP PCI-X 4-Channel Smart Array 6404, Ultra320 SCSI (A9891A)
• HP PCI-X Single Channel Smart Array P600, SAS 3.0 (337972-B21) (consists of twoMSA50

storage enclosures attached in series)

RAID Controller

• HP USB/VGA card (A6869A) (in the I/O chassis, attached to the root cell only) (supported
in rx8620 only)

• HP USB/VGA card (A6869B) (in the I/O chassis, attached to the root cell only) (supported
in both rx8620 and rx8640)

VGA Graphics
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NOTE: The rx8620 server supports multiple SA53xx cards connected to internal drives for
either boot or for data. For example, one slot may hold a SA53xx card connected to two internal
drives for boot and another may hold a SA53xx card connected to two internal drives for data.
Or, each card may be connected to two internal drives for data.

rx7640
Table 1-4 Components supported with rx7640

• Windows Server 2003, Enterprise Edition with SP1/SP2 for Itanium-based Systems
• Windows Server 2003, Datacenter Edition with SP1/SP2 for Itanium-based Systems

Operating System

• HP PCI 1000Base-T Gigabit Ethernet Adapter for Windows (A7061A)
• HP PCI 1000Base-SX Gigabit Ethernet Adapter for Windows (A7073A)
• HP PCI-X Dual Port Gigabit Ethernet SX adapter (A9899A)
• HP PCI-X Dual Port Gigabit Ethernet TX adapter (A9900A)
• HP PCIe Gigabit Ethernet adapter SX 2P (AD338A)
• HP PCIe Gigabit Ethernet adapter TX 2P (AD337A)
• HP PCI-X Windows/Linux 10 GigE (AD144A)

LAN Adapter

• HP PCI Single Channel Ultra160 SCSI Adapter for Windows (A7059A)
• HP PCI Dual Channel Ultra160 SCSI Adapter for Windows (A7060A)
• HP PCI-X Dual Channel Ultra320 SCSI Host Bus Adapter (A7173A)

(supported as accessory card and as embedded core I/O)

SCSI Adapter

• HP PCI-X (Castor AB290A) U320 SCSI/GigE Combination cardSCSI /LAN Combination
Adapter

• HP StorageWorks 2 Gb Fibre Channel HBA (AB232A)
• HP StorageWorks 2 Gb, 64-Bit/133 MHz PCI-X-to-Fibre Single Channel HBA

(AB467A)
• HPStorageWorks 2Gb, 64-Bit/133MHzPCI-X-to-FibreDualChannelHBA (AB466A)
• HP StorageWorks 4 Gb Single Port 64-bit 266 MHz Fibre Channel HBA (AB429A)
• HP StorageWorks 4 Gb Dual Port 64-bit 266 MHz Fibre Channel HBA (AB379A)
• HP StorageWorks 4 Gb Dual Port 64-bit 266 MHz Fibre Channel HBA (AB379B)
• HP StorageWorks 4 Gb Dual Port Fibre Channel HBA (AD168A)
• HP StorageWorks 4 Gb Single Port Fibre Channel HBA (AD167A)
• HP StorageWorks FC2142 PCIe Single Port 4 Gb Fibre Channel adapter (A8002A)
• HP StorageWorks FC2242 PCIe Dual Port 4 Gb Fibre Channel adapter (A8003A)
• HP StorageWorks FC1142 PCIe Single Port 4 Gb Fibre Channel adapter (AE311A)
• HP StorageWorks AD300A PCIe Dual Port 4 Gb Fibre Channel adapter (AD300A)

Fibre Channel Adapter

• HP PCI-X Dual Channel Smart Array 6402, Ultra320 SCSI (A9890A)
• HP PCI-X 4-Channel Smart Array 6404, Ultra320 SCSI (A9891A)
• HP PCI-X Single Channel Smart Array P600, SAS 3.0 (337972-B21) (consists of two

MSA50 storage enclosures attached in series)
• HP PCIe Smart Array P800, SAS (AD335A)
• HP PCIe Smart Array E500, SAS (AH226A)

RAID Controller

• HP USB/VGA card (A6869B) (in the I/O chassis, attached to the root cell only)
(supported in both rx7620 and rx7640)

VGA Graphics
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NOTE: The rx7640 server supports multiple SA64xx cards connected to internal drives for
either boot or for data. For example, one slot may hold a SA64xx card connected to two internal
drives for boot, and another slot may hold a SA64xx card connected to two internal drives for
data. Or, each card may be connected to two internal drives for data.

rx7620
Table 1-5 Components supported with rx7620

• Windows Server 2003, Enterprise Editionwith SP1/SP2 for Itanium-based Systems
• Windows Server 2003, Datacenter Editionwith SP1/SP2 for Itanium-based Systems

Operating System

• HP PCI 1000Base-T Gigabit Ethernet Adapter for Windows (A7061A)
• HP PCI 1000Base-SX Gigabit Ethernet Adapter for Windows (A7073A)
• HP PCI-X Dual Port Gigabit Ethernet SX adapter (A9899A)
• HP PCI-X Dual Port Gigabit Ethernet TX adapter (A9900A)
• HP PCI-X Windows/Linux 10 GigE (AD144A)

LAN Adapter

• HP PCI Single Channel Ultra160 SCSI Adapter forWindows (A7059A) (supported
as accessory card and as embedded core I/O)

• HP PCI Dual Channel Ultra160 SCSI Adapter for Windows (A7060A) (supported
as accessory card and as embedded core I/O)

• HP PCI-X Dual Channel Ultra320 SCSI Host Bus Adapter (A7173A)

SCSI Adapter

• HP PCI-X (Procurium A6794A) U160 SCSI / GigE Combination cardSCSI/LAN Combination
Adapter

• HP StorageWorks 2 Gb Fibre Channel HBA (AB232A)
• HP StorageWorks 2 Gb, 64-Bit/133 MHz PCI-X-to-Fibre Dual Channel HBA

(AB466A)
• HP StorageWorks 2 Gb, 64-Bit/133 MHz PCI-X-to-Fibre Single Channel HBA

(AB467A)
• HP StorageWorks 4 Gb Single Port Fibre Channel HBA (AD167A)
• HP StorageWorks 4 Gb Dual Port Fibre Channel HBA (AD168A)

Fibre Channel Adapter

• HP PCI-X Dual Channel Smart Array 6402, Ultra320 SCSI (A9890A)
• HP PCI-X 4-Channel Smart Array 6404, Ultra320 SCSI (A9891A)
• HP PCI-X Single Channel Smart Array P600, SAS 3.0 (337972-B21) (consists of two

MSA50 storage enclosures attached in series)

RAID Controller

• HP USB/VGA card (A6869A) (in the I/O chassis, attached to the root cell only)
(supported in rx7620 only)

• HP USB/VGA card (A6869B) (in the I/O chassis, attached to the root cell only)
(supported in both rx7620 and rx7640)

VGA Graphics
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NOTE: The rx7620 server supports multiple SA64xx cards connected to internal drives for
either boot or for data. For example, one slot may hold a SA64xx card connected to two internal
drives for boot and another slot may hold a SA64xx card connected to two internal drives for
data. Or, each card may be connected to two internal drives for data.

rx6600
Table 1-6 Components supported with rx6600

• Windows Server 2003, Enterprise Edition with SP2 for Itanium-based Systems
• Windows Server 2003, Datacenter Edition with SP2 for Itanium-based Systems

Operating System

• HP PCI-X Dual Port Gigabit Ethernet SX adapter (A9899A) (Supported as an accessory
card and as core I/O)

• HP PCI-X Dual Port Gigabit Ethernet TX adapter (A9900A)
• HP PCI-X Windows/Linux 10 GigE (AD144A)
• HP PCIe Gigabit Ethernet adapter SX 2P (AD338A)
• HP PCIe Gigabit Ethernet adapter TX 2P (AD337A)

LAN Adapter

• HP PCI-X Dual Channel Ultra320 SCSI Host Bus Adapter (A7173A)SCSI Adapter

• HP StorageWorks 4 Gb Single Port 64-bit 266 MHz Fibre Channel HBA (AB429A)
• HP StorageWorks 4 Gb Dual Port 64-bit 266 MHz Fibre Channel HBA (AB379A)
• HP StorageWorks 4 Gb Dual Port 64-bit 266 MHz Fibre Channel HBA (AB379B)
• HP StorageWorks 4 Gb Single Port 64-bit 266 MHz Fibre Channel HBA (AD167A)
• HP StorageWorks 4 Gb Dual Port 64-bit 266 MHz Fibre Channel HBA (AD168A)
• HP StorageWorks FC2142 PCIe Single Port 4 Gb Fibre Channel adapter (A8002A)
• HP StorageWorks FC2242 PCIe Dual Port 4 Gb Fibre Channel adapter (A8003A)
• HP StorageWorks FC1142 PCIe Single Port 4 Gb Fibre Channel adapter (AE311A)
• HP StorageWorks AD300A PCIe Dual Port 4 Gb Fibre Channel adapter (AD300A)

Fibre Channel
Adapter

• HPPCI-X Single Channel Smart Array P600, SAS 3.0 (337972-B21) (consists of twoMSA50
storage enclosures attached in series, supported as accessory card and core I/O.)

• HP PCIe Smart Array P800 (AD335A)
• HP PCI-Express Smart Array P400 (401532-B21)
• HP PCI-Express Smart Array E500 (AH226A)

RAID Controller

• Integrity Integrated Lights-Out (iLO 2)
• Integrity iLO Advanced Pack

Management
Processor
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rx4640
Table 1-7 Components supported with rx4640

• Windows Server 2003, Enterprise Edition with SP1 for Itanium-based Systems
• Windows Server 2003, Datacenter Edition with SP1 for Itanium-based Systems

Operating System

• HP PCI 1000Base-T Gigabit Ethernet Adapter for Windows (A7061A)
• HP PCI 1000Base-SX Gigabit Ethernet Adapter for Windows (A7073A)
• HP PCI-X Dual Port Gigabit Ethernet SX adapter (A9899A)
• HP PCI-X Dual Port Gigabit Ethernet TX adapter (A9900A)

LAN Adapter

• HP PCI Single Channel Ultra160 SCSI Adapter for Windows (A7059A)
• HP PCI Dual Channel Ultra160 SCSI Adapter for Windows (A7060A)

(supported as accessory card and as core I/O)

• HP PCI-X Dual Channel Ultra320 SCSI Host Bus Adapter (A7173A)
(supported as accessory card and as core I/O)

SCSI Adapter

• HP StorageWorks 2 Gb Fibre Channel HBA (AB232A)
• HP StorageWorks 2 Gb, 64-Bit/133 MHz PCI-X-to-Fibre Dual Channel HBA (AB466A)
• HP StorageWorks 2 Gb, 64-Bit/133 MHz PCI-X-to-Fibre Single Channel HBA (AB467A)
• HP StorageWorks 2 Gb Fibre Channel Host Bus Adapter (A7298A)

Fibre Channel
Adapter

• HPPCI-XDual Channel SmartArray 6402, Ultra320 SCSI (A9890A) (supported as accessory
card and as core I/O)

• HP PCI-X Single Channel Smart Array P600, SAS 3.0 (337972-B21) (consists of twoMSA50
storage enclosures attached in series)

RAID Controller

• HP USB/VGA card (A6869A) (supported as embedded device only)VGA Graphics

rx3600
Table 1-8 Components supported with rx3600

• Windows Server 2003, Enterprise Edition with SP1/SP2 for Itanium-based Systems
• Windows Server 2003, Datacenter Edition with SP1/SP2 for Itanium-based Systems

Operating System

• HP PCI-X Dual Port Gigabit Ethernet SX adapter (A9899A)
• HP PCI-X Dual Port Gigabit Ethernet TX adapter (A9900A)
• HP PCI-X Windows/Linux 10 GigE (AD144A)
• HP PCIe Gigabit Ethernet adapter SX 2P (AD338A)
• HP PCIe Gigabit Ethernet adapter TX 2P (AD337A)

LAN Adapter

• HP PCI-X Dual Channel Ultra320 SCSI Host Bus Adapter (A7173A)SCSI Adapter

• HP StorageWorks 4 Gb Single Port 64-bit 266 MHz Fibre Channel HBA (AB429A)
• HP StorageWorks 4 Gb Dual Port 64-bit 266 MHz Fibre Channel HBA (AB379A)
• HP StorageWorks 4 Gb Dual Port 64-bit 266 MHz Fibre Channel HBA (AB379B)
• HP StorageWorks 4 Gb Single Port 64-bit 266 MHz Fibre Channel HBA (AD167A)
• HP StorageWorks 4 Gb Dual Port 64-bit 266 MHz Fibre Channel HBA (AD168A)
• HP StorageWorks FC2142 PCIe Single Port 4 Gb Fibre Channel adapter (A8002A)
• HP StorageWorks FC2242 PCIe Dual Port 4 Gb Fibre Channel adapter (A8003A)
• HP StorageWorks FC1142 PCIe Single Port 4 Gb Fibre Channel adapter (AE311A)
• HP StorageWorks AD300A PCIe Dual Port 4 Gb Fibre Channel adapter (AD300A)

Fibre Channel
Adapter
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Table 1-8 Components supported with rx3600 (continued)

• HP PCI-X Single Channel Smart Array P600, SAS 3.0 (337972-B21) (consists of twoMSA50
storage enclosures attached in series) (supported as accessory card and as core I/O.)

• HP PCIe Smart Array P800 (AD335A)
• HP PCI-Express Smart Array P400 (401532-B21)
• HP PCI-Express Smart Array E500 (AH226A)

RAID Controller

• Integrity iLO 2
• Integrity iLO Advanced Pack

Management
Processor

rx2660
Table 1-9 Components supported with rx2660

• Windows Server 2003, Enterprise Edition with SP1/SP2 for Itanium-based Systems
• Windows Server 2003, Datacenter Edition with SP1/SP2 for Itanium-based Systems

Operating System

• HP PCI-X Dual Port Gigabit Ethernet SX adapter (A9899A)
• HP PCI-X Dual Port Gigabit Ethernet TX adapter (A9900A)
• HP PCI-X Windows/Linux 10 GigE (AD144A)
• HP PCIe Gigabit Ethernet adapter SX 2P (AD338A)
• HP PCIe Gigabit Ethernet adapter TX 2P (AD337A)

LAN Adapter

• HP PCI-X Dual Channel Ultra320 SCSI Host Bus Adapter (A7173A)SCSI Adapter

• HP StorageWorks 4 Gb Dual Port 64-bit 266 MHz Fibre Channel HBA (AB379A)
• HP StorageWorks 4 Gb Dual Port 64-bit 266 MHz Fibre Channel HBA (AB379B)
• HP StorageWorks 4 Gb Single Port 64-bit 266 MHz Fibre Channel HBA (AB429A)
• HP StorageWorks 4 Gb Single Port 64-bit 266 MHz Fibre Channel HBA (AD167A)
• HP StorageWorks 4 Gb Dual Port 64-bit 266 MHz Fibre Channel HBA (AD168A)
• HP StorageWorks FC2142 PCIe Single Port 4 Gb Fibre Channel adapter (A8002A)
• HP StorageWorks FC2242 PCIe Dual Port 4 Gb Fibre Channel adapter (A8003A)
• HP StorageWorks FC1142 PCIe Single Port 4 Gb Fibre Channel adapter (AE311A)
• HP StorageWorks AD300A PCIe Dual Port 4 Gb Fibre Channel adapter (AD300A)

Fibre Channel
Adapter

• HP PCI-X Single Channel Smart Array P600, SAS 3.0 (337972-B21) (consists of twoMSA50
storage enclosures attached in series)

• HP PCIe Smart Array P800 (AD335A)
• HP PCI-Express Smart Array P400 (405160-B21)
• HP PCI-Express Smart Array E500 (AH226A)

RAID Controller

• Integrity iLO 2
• Integrity iLO Advanced Pack

Management
Processor

rx2620
Table 1-10 Components supported with rx2620

• Windows Server 2003, Enterprise Edition with SP1/SP2 for Itanium-based Systems
• Windows Server 2003, Datacenter Edition with SP1/SP2 for Itanium-based Systems

Operating System

• HP PCI 1000Base-T Gigabit Ethernet Adapter for Windows (A7061A)
• HP PCI 1000Base-SX Gigabit Ethernet Adapter for Windows (A7073A)
• HP PCI-X Dual Port Gigabit Ethernet SX adapter (A9899A)
• HP PCI-X Dual Port Gigabit Ethernet TX adapter (A9900A)
• HP PCI-X Windows/Linux 10 GigE (AD144A)

LAN Adapter
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Table 1-10 Components supported with rx2620 (continued)

• HP PCI Single Channel Ultra160 SCSI Adapter for Windows (A7059A)
• HP PCI Dual Channel Ultra160 SCSI Adapter for Windows (A7060A)
• HP PCI-X Dual Channel Ultra320 SCSI Host Bus Adapter (A7173A)

(supported as accessory card and as embedded core I/O)

SCSI Adapter

• HP StorageWorks 2 Gb Fibre Channel HBA (AB232A)
• HP StorageWorks 2 Gb, 64-Bit/133 MHz PCI-X-to-Fibre Dual Channel HBA (AB466A)
• HP StorageWorks 2 Gb, 64-Bit/133 MHz PCI-X-to-Fibre Single Channel HBA (AB467A)
• HP StorageWorks 2 Gb Fibre Channel Host Bus Adapter (A7298A)

Fibre Channel
Adapter

• HP PCI-X Dual Channel Smart Array 6402, Ultra320 SCSI (A9890A)
• HP PCI-X 4-Channel Smart Array 6404, Ultra320 SCSI (A9891A)
• HPPCI-X Single Channel SmartArray P600, SAS 3.0 (337972-B21) (consists of twoMSA50

storage enclosures attached in series)

RAID Controller

• Integrity iLO plus VGA A9803A
• Integrity iLO Advanced Pack features AB500A

Management
Processor Card with
VGA

rx1620
Table 1-11 Components supported with rx1620

• Windows Server 2003, Enterprise Edition with SP1/SP2 for Itanium-based Systems
• Windows Server 2003, Datacenter Edition with SP1/SP2 for Itanium-based Systems

Operating System

• HP PCI 1000Base-T Gigabit Ethernet Adapter for Windows (A7061A)
• HP PCI 1000Base-SX Gigabit Ethernet Adapter for Windows (A7073A)
• HP PCI-X Dual Port Gigabit Ethernet SX adapter (A9899A)
• HP PCI-X Dual Port Gigabit Ethernet TX adapter (A9900A)
• HP PCI-X Windows/Linux 10 GigE (AD144A)

LAN Adapter

• HP PCI-X Dual Channel Ultra320 SCSI Host Bus Adapter (A7173A)
(supported as accessory card and as embedded core I/O)

SCSI Adapter

• HP StorageWorks 2 Gb, 64-Bit/133 MHz PCI-X-to-Fibre Dual Channel HBA (AB466A)
• HP StorageWorks 2 Gb, 64-Bit/133 MHz PCI-X-to-Fibre Single Channel HBA (AB467A)

Fibre Channel
Adapter

• HP PCI-X Dual Channel Smart Array 6402, Ultra320 SCSI (A9890A)
• HP PCI-X 4-Channel Smart Array 6404, Ultra320 SCSI (A9891A)
• HPPCI-X Single Channel Smart Array P600, SAS 3.0 (337972-B21) (consists of twoMSA50

storage enclosures attached in series)

RAID Controller

• Integrity iLO plus VGA A9803A
• Integrity iLO Advanced Pack features AB500A

Management
Processor Card with
VGA
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NOTE: On rx1620, Windows Server 2003 supports 256 MB, 512 MB, 1 GB, and 2 GB DIMMS
only. 4 GBDIMMs are not supported.Whenmigrating from another OS toWindows Server 2003
on servers where 4 GB DIMMs are installed, replace the 4 GB DIMMs with supported DIMMs.

BL860c and BL870c Server Blade
Table 1-12 Components supported with BL860c and BL870c

• Windows Server 2003, Enterprise Edition with SP1/SP2 for Itanium-based Systems
• Windows Server 2003, Datacenter Edition with SP1/SP2 for Itanium-based Systems

Operating System

• Dual Port 4Gb/s FC Mezzanine Card (Q-Logic) (403619-B21)
• Direct Adaptor Mezzanine Card for connecting to the Direct Attached Storage Blade

(431643-B21)
• PCI Express Quad Port Gigabit Server Mezzanine (447883-B21)

I/O Mezzanine
Support

Troubleshooting Common Issues
Read this section completely before installing or running Windows Server 2003 on HP Integrity
servers. This section includes workarounds that may save you valuable time and effort.

Array Configuration Utility (ACU)

verifer.exe causes ACU inaccuracies
Issue ACU reports incorrect results when the Windows Driver Verifier

(verifier.exe) is enabled and running in the background.
Servers All Integrity
Workaround There is no workaround at this time. To run the ACU, you must first end the

verifier.exe process using the Windows Task Manager, then launch ACU.
Do not run both simultaneously.

Array Diagnostic Utility (ADU)

Uninstall feature not functional
Issue The ADU uninstall feature is not working.
Servers All Integrity
Workaround There is no workaround at this time.

Clustering

Cluster nodes unable to see messages
Issue Normally in a cluster, when an application in one node logs an event to the

Windows Event Log, themessage is visible to all nodes in the cluster. However,
due to aMicrosoft limitation, when events are loggedwithmore than 900 bytes
in the lpRawData binary field (as reported by the Microsoft ReportEvent
API), only the node that issued the event can see it using the Windows Event
Viewer. Other nodes in the cluster are unable to see these messages.

Servers Superdome, rx8620, rx7620
Workaround There is no workaround at this time.
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Device Drivers

Missing driver affects Virtual Machines
Issue The HP Integrity Baseboard Management Controller Device Driver must be

installed on all VMs for the HP Integrity VM Provider to function correctly on
these systems. The baseboard Management Controller driver (also known as
theHPHealthDriver) automatically installs from the Support Pack andReinstall
Media, or can be manually installed from the HP Smart Setup CD.

Servers All Integrity
Workaround To manually check for the IPMI driver open the Windows Device Manager by

right-clicking My Computer, and selecting Manage > Device Manager. The
IPMI is located under System Devices as the HP Baseboard Management
Controller Interface Device (Health Driver is an older name for this driver). If
the driver is missing, install it from the HP Smart Setup CD.

Drivers missing from RTM media
Issue If you installed the operating system fromMicrosoft RTMmedia, youmust also

install device drivers for the HP Integrity server for all devices displaying a
yellow “bang” icon in the system device manager. These drivers are available
on the HP Smart Setup CD.

Servers All Integrity
Workaround To install a device driver from the HP Smart Setup CD:

1. Insert the HP Smart Setup CD in the server CD/DVD drive.
2. Read the End User License Agreement. If you agree to the terms of the

license agreement, click Agree to continue.
3. Run the Windows Device Manager, and click View > Devices by Type to

list the system devices.
4. Expand the Other devices entry. This displays a list of all devices whose

drivers were not found during installation of the operating system. Some
of these devicesmay have a specific name,while others appear as Unknown
Device. Each item is indicated by a small yellow exclamation mark icon
next to its name.

5. Right-click the first item, and selectUpdate Driver from the context menu.
6. In the Hardware Update Wizard screen, select Install the software

automatically and click Next.
7. If awarning dialog appears stating the driver is not digitally signed, ignore

the message. This is not an issue. Click Next to continue.
8. When successful installation is indicated, click Finish.

Driver roll back causes crash
Issue If SecurePath software is installed and you attempt to roll back from the Storport

device driver to the SCSIport driver, the system crashes with a blue screen.
Servers All Integrity
Workaround This is an operating system bug. See the Microsoft Knowledge Base article

#903081, titled Storport Update at http://support.microsoft.com/?kbid=903081.

prlntss.sys installation issue
Issue The U320 Event notification driver (prlntss.sys) does not install correctly

after a Support Pack installation following an operating system installation
using SP1 slipstream or RTMmedia. The problem only occurs with Integrity
servers booting from a U320 controller (embedded or HBA) with the external
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port connected to an MSA30 after a fresh operating system installation. The
problemdoes not occur if you install the operating systemusingReinstallmedia,
or if the U320 is not used as a boot controller.

Servers All Integrity
Workaround Install the driver using the individual Smart Component only found on the

Software tab on your HP Smart Setup CD. Click the HP StorageWorks Event
Notification Driver for Ultra320 SCSI devices for Windows Server 2003 on
Itanium-based Systems link.

Extensible Firmware Interface (EFI) and EFI-based Setup Utility (EBSU)

I/O card firmware values display as unknown
Issue EBSU's Maintain Firmware feature displays some I/O card firmware values as

unknown in the Local version column. This occurswhen the card firmware
does not return a data structure that EBSU recognizes because the card firmware
is configured for 32-bit systems, it lacks an EFI driver, or has corrupted firmware.

Servers All Integrity
Workaround Try flashing the card firmware to correct the problem. If the card still has

unknown values after flashing it and resetting the system, contact your local
support specialist or visit http://www.hp.com/support/itaniumservers for help.

QLogic HBA firmware and EFI driver revisions display incorrectly
Issue The EBSU Maintain Firmware feature and the SANsurfer FC HBAManager

utility VPD tab might display QLogic HBA firmware and EFI driver values
incorrectly after the binaries have been updated. No functionality issues exist
because the binary itself is correctly flashed to the adapters Option ROM. For
this to occur, a QLogic multi-boot package must be first updated using
SANsurfer on a Windows IA64 system and then later updated in the EFI Shell
by EBSU. These separate events can occur hours or even months apart.

Servers All Integrity
Workaround Flash the QLogic multi-boot package again using SANsurfer on a Windows

system. The firmware and EFI driver values display correctly during the HBA
PowerOn Self Test (POST)while booting up. These values also display correctly
in the Option ROM section on the Information tab in the SANSurfer FC HBA
Manager utility.

EBSU displays incorrect CPU version
Issue EBSU might display an inconsistent CPU version in the system inventory due

to a system firmware issue.
Servers rx4640
Workaround Run info cpu on the EFI shell, and check the Rev column for the specific CPU

module to determine the CPU version.

EBSU displays incorrect firmware version
Issue EBSU displays the Emulex 4 Gigabit cards (FC2143 and FC2243) firmware

version 2.10A10 as 2.10A1.
Servers sx2000, sx1000, rx8640, rx8620, rx7640, rx7620, rx6600, rx3600, rx2660
Workaround Run the Storage Adapter configuration for the Emulex card on EBSU. If the

configuration tool lists more than one card, select the intended card on the tool
and the firmware version is displayed correctly.
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EBSU changes EFI Boot menu
Issue If EBSU runs from vMedia, it changes the EFI Boot menu Internal Bootable

DVD to point to the vMedia device.
Servers sx2000, rx8640, rx7640, rx6600, rx3600, rx2660, HP Integrity BL860c Server Blade,

HP Integrity BL870c Server Blade
Workaround Using the EFI BootManager, choseBoot Configuration andmodify the Internal

Bootable DVD menu entry with the correct device path.

Foundation Agents

Memory leak generated by Foundation Agents
Issue If a hardware communication problem exists with the BaseboardManagement

Controller (BMC), the Foundation Agents service (cqmghost.exe) might
continually increase its memory usage. The underlying Application
Programming Interface (API) requests memory and fails to deallocate it during
the BMC hardware error condition.

Servers All Integrity
Workaround Whenunacceptablememory usage is reached, reset the BMCusing theMPuser

interface or restart the Foundation Agent service. If this does not resolve the
issue, it might be necessary to contact hardware support. This issue will be
resolved in a future release of the HP Smart Setup CD.

Hard Disk Configuration

Disk configuration lost after reboot
Issue When configuring a boot LUN in EBSU Express Install using a direct connect

configuration to an MSA1000, the storage hard disk device configuration may
be lost after rebooting the system.

Servers All Integrity
Workaround The Emulex FC EFI driver (minimum rev. 3.11a4) has a Device Discovery delay

function. Go to Setup Utility > Configure Boot Parameters and change the
Delay Device Discovery parameter to 30.

HP c-Class Blade System Infrastructure

Onboard Administrator displays wrong CPU
Issue The Onboard Administrator displays wrong CPU information for the c-Class

enclosure where the HP Integrity BL860c or BL870c Server Blade resides. It
incorrectly reports that the CPU is Dual Core instead of Single Core.

Servers HP Integrity BL860c and BL870c Server Blades
Workaround There is no workaround for this problem.

BL870c SAS controller supports only one mirror
Issue The embedded SAS controller on the BL870c Server Blade can only support one

mirror. The mirror can be a two-drive mirror or a two-drive mirror with a hot
spare. Although there are four total drive bays available in the BL870c, you can
use only three of them (maximum) because of this limitation.

Servers HP Integrity BL870c Server Blade
Workaround There is no workaround for this problem.
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Fibre Channel

Installation causes MSA 1500 driver to be flagged
Issue A yellow exclamation mark (!) might be displayed for the HP StorageWorks

1000/ MSA 1500 event notification driver after installing the Windows Server
2003 SP2 operating system using the 5.2 release reinstall media.

Servers All Integrity
Workaround Using the Release 5.2HP Smart SetupMedia (SSM)CD, do one of the following:

• Install the Support Pack (recommended).
• Install HP StorageWorks MSA1000/MSA1500 Event Notification Driver

component.

Support Pack update generates errors
Issue When updating a system using the Support Pack from the HP Smart Setup 5.1

CD, errorsmay be reported in theWindows application event log. The indicated
source is Emulex HBAnyware.

Servers All Integrity
Workaround Ignore these error messages. The Support Pack first installs the new SCSIPort

or STORPort driver, and then updates HBAnyware. The new drivers are not
compatible with the previous revision of HBAnyware, causing the event log
errors. After the new version of HBAnyware is installed, this issue is resolved.

Inapplicable errors seen in kit update
Issue Whenupdating theHP StorageWorks Fibre ChannelAdapter Kit for the Emulex

Storport driver, the following error message might be displayed in a pop-up
window:
Windows cannot find 'C:\Program'. Make sure you typed the name
correctly, then try again. To search for a file, click the Start
button, then click Search

Servers All Integrity
Workaround You can ignore this error message. The Support Pack first installs the new

SCSIPort or STORPort driver, and then updates HBAnyware. The new drivers
are not compatiblewith the previous revision ofHBAnyware, causing the event
log errors. After the new version of HBAnyware is installed, this issue is
resolved.

Redundant entries seen in the Add/Remove Program
Issue The Add/Remove Program contains two entries after upgrading the HP

StorageWorks FC-HBA Configuration Utilities by QLogic for Windows Server
2003 Itanium-based systems from revision 2.0.30.78 to revision 5.0.0.4.

Servers All Integrity
Workaround Uninstall HP StorageWorks FC-HBA Configuration Utilities by QLogic for

Windows Server 2003 Itanium-based systems revision 2.0.30.78 before installing
revision 5.0.0.4.

Emulex HBAs use different driver
Issue After performing an operating system installation using Microsoft reinstall

media or updating an existing installation using the Support Pack from the HP
Smart Setup CD, the Emulex HBAs now use the STORPORT driver instead of
the SCSIPort driver previously used.

Servers All Integrity

Troubleshooting Common Issues 27



Workaround This is not an error. HP is making the STORPORT driver the new default for
Emulex 4Gb PCI-X 2.0 and PCI-Express HBAs because this driver offers
improved performance and manageability features. However, if you are
currently running the SCSIPort driver and want to continue using, you must:
1. Uninstall the STORPORT driver after using the Microsoft reinstall media

or clear the Emulex Storport driver checkbox during the Support
Pack update from the HP Smart Setup CD.

2. Install the SCSIPort driver using the Smart Component in the Others
directory on the HP Smart Setup CD. This driver is also available for
download at http://www.hp.com/.

MSA fails with Storport driver installed
Issue MSA flash utility version 6.86.1.52 used onActive-ActiveMSAControllers, and

version 5.10.1.52 used on Active-Passive Controllers will fail to run when the
latest Storport driver (KB916048) is installed.

Servers All Integrity
Workaround Use the MSA Flash utility with the fix that will be available on the HP web site

at the following Web site:
http://h20000.www2.hp.com/bizsupport/TechSupport/SoftwareIndex.jsp?lang=en&cc=us&
prodNameId=415600&prodTypeId=12169&prodSeriesId=415598&swLang=13&swEnvOID=1060

LUNs undetected by ACU
Issue The ACU does not detect any LUNs attached to an AB379A or AB429A HBA

that has been swapped or added using the Online Add/Replace function while
the ACU was running.

Servers sx2000, rx8640, rx7640, rx6600, rx3600
Workaround Stopping and restarting the ACU corrects this issue. The ACU then sees the

LUNs attached to the AB379A or AB429A HBAs.

HBA removal fails
Issue When attempting to remove the AB379A or AB429A HBA using the Online

Replace functionality, a message appears:
The device ‘Qlogic Fibre Channel Adapter’ cannot be 
stopped because a program is still accessing it.

Servers sx2000, rx8640, rx7640, rx6600, rx3600
Workaround 1. Stop the QLogic Management Suite Java Agent in the Services window

under Computer Management.
2. Stop the AB379A or AB429A using the Safely Remove Hardware function.

HP-SUM hangs on MSA 1500 boot
Issue HP Smart Update Manager (HP-SUM) hangs when an MSA 1500 connected to

QLogic boots.
Servers All Integrity
Workaround This is an MSA firmware problem. There is no workaround at this time. New

firmware is expected in January 2008.
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HPVM

Patches required on virtual machine guests
Issue Microsoft patches correct a compiler issue that can affect HPVMWindows

virtual machine guests. These issues can manifest in various ways, including
blue screens.

Servers All Integrity
Workaround Ensure that you install allMicrosoft patches andQuick Fix Engineering updates

(QFEs) that are available on the current HP Smart Update media.

Installation

Attempting installation from a second DVD drive results in system message
Issue If you attempt to install a Smart component from the second DVD drive of a

system that contains multiple DVD drives, you are prompted to insert a DVD
into the first drive and the component is not installed. For example, consider a
system that has two DVD drives, the first of which is the D:\ drive and the
second is the E:\ drive. If you attempt to install a Smart component such as
Virus Throttle from the E:\ drive, the system assumes it is running from D:\
and issues a message about the missing DVD. This problem also occurs if your
system runs an iLO DVD drive as a second drive and if you use CD media.

Servers All Integrity
Workaround To avoid this issue, run the Smart components from first DVD drive.

Japanese QFE package fails to install all QFEs
Issue The Japanese operating system Quick Fix Engineering (QFE) package

cp007519.exe forWindows Server 2003with Service Pack 2 does not install
correctly. The package should install four QFEs, but only three are installed.
You can confirm this by going to Add/Remove Programs in the Control
Panel.When you check theShow Updates box, only threeQFEs are displayed;
the Microsoft QFE package 929054 does not appear.

Servers HP Superdome (sx2000), HP Superdome (sx1000), rx8640, rx8620, rx7640,
rx7620, rx4640, rx3600, rx2660, rx2620, rx1620, HP Integrity BL860c, HP
Integrity BL870c

Workarounds Rerun smart component cp007519.exe. You will now see QFE 929054 in
the Control Panel.

Installation from graphics console may require additional steps
Issue When using vKVM to install Windows Server 2003 on rx3600 or rx6600 with a

graphics console attached, you must either disconnect the graphics console or
edit the boot entry to add the /NOVESA option.

Servers rx6600, rx3600
Workaround For more information on editing boot entries, see the Smart Setup Guide.

Hyper-threading may cause installation failure
Issue When installing the operating system using Microsoft reinstall media on a

system with hyper-threading enabled, the installation might fail.
Servers Superdome (sx2000), rx8640, rx7640, rx6600, rx4640, rx3600, rx2660, rx2620
Workaround Before installing the operating system from Microsoft reinstall media, disable

hyper-threading. After installing the operating system, you must install KB

Troubleshooting Common Issues 29



#919385 from the HP Smart Update media. Hyper-threading can then be
re-enabled.

Component times outs cause installation failure
Issue If a Smart Component takes longer than 15 minutes to install, the installation

of the Support Pack most likely fails. This normally occurs in cases where the
system has many cards, such as numerous NIC cards, installed.

Servers All Integrity
Workaround Install the Smart Component separately, and then install the Support Pack.

Screen is blank at system startup
Issue During system startup the screen may remain blank for 3 to 8 minutes (actual

time depends on the quantity of the installed system memory).
Servers All Integrity
Workaround This is normal. The system activity can be monitored within a few seconds of

system power-on using a remote terminal.

Use of 16 GB option discouraged
Issue If you use the 16 GB option during installation of the operating system from

reinstall media, you cannot create a kernel memory dump (in the event of a
system failure) unless the page file size is manually configured afterward. In
addition, evenwithmanual configuration the page file sizewill still be less than
the recommended 20 GB.

Servers All Integrity
Workaround The system partition must be created on a 33 GB or larger disk drive. When

using reinstall media, select either the 33 GB or maximum drive size option
when configuring the system volume.

Maximum Payload Size parameter must be off
Issue HP Integrity servers based on theHPZX2 chipset using PCIexpress backplanes

allow the user to control a feature called Maximum Payload Size (MPS). This
feature must be off for Windows Server 2003, and is delivered off on
factory-installed system. If the server is ever usedwith another operating system,
ensure that the MPS setting is off before installing Windows Server 2003.

Servers rx6600, rx3600, rx2660, HP Integrity BL860c Server Blade, HP Integrity BL870c
Server Blade

Workaround Use the ioconfig in EFI to view and configure this value. To view the value,
enter:
shell>ioconfig

To turn the value off (required on Windows Server 2003), enter:
shell>shell> ioconfig mps_optimize off

To turn the value on, enter:
shell>shell> ioconfig mps_optimize on

Use Esc+8 instead of F8 key on headless server
Issue The Telnet and Hyperterminal applications on Windows NT4 and Windows

2000 do not correctly map the ASCII string for the function keys. For example,
during Power On Self Test (POST) the Smart Array firmware displays a banner
and configuration menu with instructions to press the Esc key to continue or
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the F8 key to enter the configuration utility. When running the system in a
headless configuration, pressing F8 does not display the configuration menu.

Servers All Integrity
Workaround To transmit the correct ASCII string using these applications from a remote

terminal, press the Esc key immediately followed (within 1 second) by the
numeric value of the desired function key. For example, to send theASCII string
for F8, press the Esc key immediately followed by the 8 key (if the terminal
emulator is set to UTF-8, you can press the F8 key instead). An easier solution
to both problems is to simply use PuTTY instead of Telnet or Hyperterminal.
PuTTY is a terminal emulator available on your HP Smart Setup CD.

Custom Install option disables Remote Desktop
Issue When installing software from the Microsoft RTM media using the Custom

Install option, Remote Desktop is disabled by default (this does not happen
with the Express Install option).

Servers All Integrity
Workaround To enable Remote Desktop after installing with the Custom Install option:

1. From the headless systemused to perform the installation, access the Special
Administration Console (SAC) on the server using terminal emulation
software such as telnet, PuTTY, or HyperTerminal.

2. At the SAC> prompt, enter cmd and press the Enter key.
3. Switch to a new command channel by pressing the Esc+Tab keys.
4. At the C:\Windows\system32> prompt, enter the following:

reg add “HKLM\system\CurrentControlset\Control\Terminal
Server” /v fdenyTSConnections /t REG_DWORD /d 0 /f and
press the Enter key.

5. At the C:\Windows\system32> prompt, enter the following:
netsh firewall set service remotedesktop enable all and
press the Enter key.

prlntss.sys requires Support Pack Installation
Servers All Integrity
Issue The Support Pack included on the HP Reinstall DVD does not include the U320

event notification driver (prlntss.sys). However, the Support Pack included
on your HP Smart Setup CD does include this driver.

Workaround If you want this driver to be included in your installation, you must use the
Support Pack installation method provided on your HP Smart Setup CD.

IP Console Switch use causes screen to blank
Issue You may experience a variable delay where the monitor (or remote session)

connected to the IP Console Switch goes blank when using the reinstallation
media.
One step in the reinstallation process is plug-and-play device discovery. During
this time, drivers are not connected to devices. Without drivers, USB ports
disable their power output. The IPConsole Switch relies on this power to transfer
video to the local and remote sessions. After the device discovery is complete,
a driver is connected, power is enabled, and video displays. The blanking time
depends on system configuration, but could take as long as 30 minutes. The
system will appear to hang, but is only going through device discovery.
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Servers All Integrity
Workaround Use the command line interface for the most complete view of system status.

The command line is active and displays status at all times prior to video
initialization at power on, and at all times during the system operation. The
command line is accessible through the Management Processor interface.

NOTE: If you have amonitor connected directly to the system, the video does
not go blank.

Network Interface Cards (NICs)

Warning message not a cause for concern
Issue At system power-up, you may see a warning message (with a source of b57nd

or e1000) indicating a disconnect.With the A7073A card, Event ID 4 is specified,
and with the A9899A card, Event ID 27.

Servers All Integrity
Workaround This is not an error, but rather a side-effect of the auto-negotiation process used

by the A7073A and A9899A cards. The cards do connect at the end of that
process. You can verify this by going into the Event Viewer, locating theWarning
message, and seeing the Informational message that follows it, indicating a
successful connection (InformationEvent ID 11 for theA7073A card; Information
Event ID 32 for the A9899A card).

Power Management

PAL_HALT_LIGHT disables idle power state
Issue The PAL_HALT_LIGHT registry edit disables the idle power state (C1) on all

Itanium processors in the system. You must reboot the system for the change
to take effect. For typical workloads, this modification improves system
performance and responsiveness at the expense of a slightly increased power
consumption.

Servers All Integrity
Workaround This is not an error. To re-enable the idle power state (C1) on all Itanium

processors in the system, remove thePAL_HALT_LIGHT registry edit by going
to Add/Remove Programs in the Control Panel. You must them reboot the
system for the change to take effect.

PAL_HALT_LIGHT status not displayed in HP-SUM, VCRM, and SMS
Issue After installation or uninstallation, the current status of the PAL_HALT_LIGHT

smart component (cp006607.exe) forWindows Server 2003 on Itanium-based
system is not indicated in the HP Smart Update Manager (HP-SUM), Version
Control RepositoryManager (VCRM), and SystemsManagement Server (SMS).

Servers All Integrity
Workaround This is not an error. Because the PAL_HALT_LIGHT smart component is actually

a registry edit rather than a true installation, its status cannot be displayed in
HP-SUM, VCRM, or SMS.

Partition Manager

C++ Runtime Library error message can be ignored
Issue During shutdown, systems running Partition Manager may display a dialog

on the GUI console indicating a Visual C++ Runtime error.
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Servers Superdome, rx8620, rx7620
Workaround This is a program error in the System Management Homepage that has no

operational impact. No user action is needed.

PXE boot on Intel Dual Core Itanium systems

Patch required to enable PXE boot
Issue A patch must be installed to RIS image-enable PXE boot on Intel Dual Core

Itanium systems.
Servers All Integrity
Workaround To install a device driver from the HP Smart Setup CD:

1. Download QFE 916860 from the Microsoft Web site.
2. Extract the ntkrnlmp.exe from the QFE package.
3. Rename the ntkrnlmp.exe file to ntkrnlmp.exe.org from Remote

installation image path.
4. Copy the new ntkrnlmp.exe to the same directory.
5. Click Start > Run, and enter cmd to open the command prompt.
6. At the command prompt, enter net stop binlsvc and net start

binlsvc to restart the RIS.

SCSI

Ultra 320 firmware update fails
Issue If a DVD-RW SCSI device with EBSU media is attached to an HP PCI-X Dual

Channel Ultra 320 SCSI card, the firmware update of this card fails.
Servers All Integrity
Workaround Copy the firmware to an EFI partition and flash the card from there.

Event log entry caused by timeout condition
Issue When running Microsoft Windows Server 2003 on an HP Integrity server with

an embedded U320 SCSI controller as the external disk drive controller,
intermittent Event ID 117 entries may be generated in the Windows Event Log
after rebooting.

Servers All Integrity
Workaround Ignore these events. They represent a timeout condition that does not cause any

system problems or data loss.

Smart Array

640x/530x generates errors in system event log
Issue Under extremely heavy I/O conditions the Smart Array 640x/530x driver

(cpqcissm) might generate Event ID 9 errors in the system event log.
Servers All Integrity
Workaround Ignore these events, as they do not cause any problems or loss of data. There is

no fix at this time.

6402 as internal disk drive controller generates errors
Issue When running the Smart Array 6402 as the internal disk drive controller,

intermittent Event ID 9 and Event ID 117 entries might be generated in the
Windows Event Log after a reboot.
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Servers All Integrity
Workaround Ignore these events, as they do not cause any problems or loss of data. There is

no fix at this time.

StorageWorks 43xx enclosures may cause errors
Issue StorageWorks 43xx enclosures in a dual bus configuration with an Ultra3 Dual

Bus I/O Module and a single power supply might report errors and fail the
logical volumes when attached to Smart Array Controllers. Port A of the
StorageWorks 44xx enclosuremight intermittently report that all drives installed
in the lower bays (Port A, bays 1-7) have been hot-plug replaced even though
the drives were not replaced.
As a result, the array controller may fail the logical volumes, causing the data
to become inaccessible. If the operating system is running from those drives,
the server might hang or display a blue screen. When the server is rebooted,
the drives appear to be working properly; however, some data might be
inaccessible. A Power-On Self-Test (POST) error message is not displayed. The
problem occurs regardless of the position of the power supply or fans in the
enclosure. This affects any StorageWorks EnclosureModel 4314R,Model 4314T,
orModel 4354R in a dual bus configurationwith anUltra3Dual Bus I/OModule
and a single power supply, attached to either Smart Array 5302 or Smart Array
5304 Controller.

Servers All Integrity
Workaround Operate the StorageWorks enclosures with a minimum of two power supplies.

Configuration utility may be inaccessible
Issue The Smart-Array Option ROM Configuration for Arrays Utility menu of the

Smart Array controller in the root cell I/O chassis (core I/O chassis) might not
be accessed when the F8 key is pressed on the USB keyboard during system
boot. This problem only occurs if you are configuring the Smart Array using
the USB keyboard connected to the HP Graphics and USB card. The serial
console from the MP should work fine.

Servers All Integrity
Workaround Do the following:

1. Boot the system to the EFI shell.
2. At the EFI prompt, enter the following:search core cell. For example,

enter search 0 if the core cell is 0.
3. When you see the Smart-Array Option ROM Configuration for Arrays

Utility menu, press the F8 key on the USB keyboard.
4. Now you should see the Smart-Array Option ROM Configuration for

Arrays Utility menu.

Tools menu radio buttons inactive
Issue When viewing the driver properties in the device manager for the Smart Array

6400 Controller, an enhanced Tools menu bar displays. This bar provides radio
buttons for launching the ACU andHP Insight Storage Agents. However, these
buttons do not work in this release of the driver.

Servers All Integrity
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Workaround Currently the preferred methods for launching these tools are:
• For the ACU, click Start > Programs > HP System Tools > HP Array

Configuration Utility XE from the Windows desktop.
• For the Insight Storage Agents, click HP Management Insight Agents

from the System Management Homepage. Scroll to the Mass Storage
section on the left panel, and click the desired controller.

640x/530x may not load during system boot
Issue During system boot, Smart Array 640x or 530x cards may not load for RAID

configuration.
Servers All Integrity
Workaround The system scans only for embedded devices. The Smart Array Option ROM

has to be loaded manually the first time. This can be done at the EFI shell by
executing a search all command. The user needs to use search x y
command (for example, search 0 8), where x is the cell number and y is the
PCI slot number

640x/530x do not rebuild the internal HDD
Issue Smart Array 530x/640x controllers do not automatically rebuild the internal

disk array when failed drives are replaced. The server backplane does not
provide themanageability features needed for SmartArray adapters to recognize
when drives are hot inserted into the system.

Servers All Integrity
Workaround By installing the Smart Array Rescan Service, the rebuild is initiated

automatically after drive replacement:
1. Download and flash the latest Smart Array firmware from

www.hp.com/support/itaniumservers. Minimum firmware revision for
the SA640x controller is 2.28. Minimum firmware revision for the SA530x
controller is 3.56.

2. Download and install the latest Array Configuration Utility (ACU-XE)
fromwww.hp.com/support/itaniumservers. Theminimumrequired revision
for the ACU-XE is 7.15.18.0.

3. Download and install the Smart Array Rescan Service from
www.hp.com/support/itaniumservers. The minimum required revision
for the Rescan Service is 0.1.

4. If an internal HDD array fails, replace the failed physical drive. The Rescan
Service will initiate the rebuild automatically (it may take up to 5 minutes
before the rebuild starts). To start the rebuild immediately, open the Array
Configuration Utility (ACU-XE) and select Refresh in the Controller State
field. The failed array begins to rebuild.

640x hot add not supported
Issue If a Smart Array 6402 or 6404 card is hot-added to a slot, the card will not

function and a yellow exclamation mark displays next to the corresponding
device in the Device Manager. Furthermore, any SA640x card added in this
manner cannot be safely removed from the system without a reboot.

Servers All Integrity
Workaround Hot adding is not currently supported for Smart Array 640x on HP Integrity

servers. You can use normal hot add procedures to insert the card, but it will
not function until the next reboot. Hot add is fully supported on SA530x.
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6400 cannot be hot-replaced during error message display
Issue The Smart Array 6400 controller cannot be hot-replaced when the following

error message appears:
The device ‘Smart Array 6400’ cannot be stopped 
because a program is still accessing it

Servers All Integrity
Workaround Restart the Storage Agents service and try to hot-replace the controller again.

Command causes machine check abort
Issue Amachine check abort (MCA) can occur when the reconnect -r command

is issued for a Smart Array SA640x with firmware version 2.74 when the server
contains multiple SA640x cards with different firmware versions.

Servers Superdome sx2000, HP Integrity Server rx8640, HP Integrity Server rx7640
Workaround HP recommends you maintain the same firmware version for all Smart Array

cards on a server.

System Management Homepage (SMH)

Components flagged with red exclamation mark
Issue When running thesetup.exe commandwithout having SystemManagement

Homepage (SMH) installed on the system, some configurable componentsmight
show up with a red exclamation mark (!) when viewed in the All
Configurable Components category of the HP Remote Deployment Utility
main window. A pop-up window with the following message might also be
displayed:
One or more components that have been selected for installation require configuration but
 are not configured. For the best results, it is recommended that you configure the components

 before installation.

Servers All Integrity
Workaround To make the red exclamation mark go away, copy the System Management

Homepage component to a writable location and then configure it.

Page lacks temperature sensor descriptions
Issue On rx2620 servers with firmware bundle version 8.1 or later, and on rx3600 and

rx6600 servers with firmware bundle version 13.2 or later, the System
Management Homepage > Recovery > Environment page displays
temperature sensors that are lacking a description under the Location column.
These are a new type of sensor that the management agent cannot read
completely. However, temperature event logging and alert generation are not
affected by this display issue.

Servers rx6600, rx3600, rx2660, rx2620
Workaround There is no workaround at this time.

Some components not shown
Issue The 5.1 version ofManagementAgents does not show the following components

under Version Control:
• HP Storage Works Event Notification Driver for Ultra320 SCSI devices for

WindowsServer 2003 on Itanium-based systems (CP006112,printss.sys)
• HP Ultra 160 SCSI Controller Driver for Windows Server 2003 on

Itanium-based systems (CP006358, sym_u3.sys)
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• HP Array Diagnostic Utility for Windows Server 2003 on Itanium-based
systems (CP006361, Hpadu.exe)

• HP StorageWorks FC-HBAConfigurationUtilities by Emulex forWindows
Server 2003 Itanium-based systems (CP006084, HBAnyware.exe)

• HP StorageWorks FC-HBAConfigurationUtilities byQLogic forWindows
Server 2003 Itanium-based systems (CP005831, SANSurferVer.exe)

Servers All Integrity
Workaround Access the component versions manually from the Support Pack, HP Smart

Setup CD, or by similar methods.
Another solution is to use https://127.0.0.1:2381 instead of
https://localhost:2381.

SMH fails to open
Issue If Internet Explorer is configured to browse through a proxy server and the

Bypass proxy server for local addresses checkbox is not selected, attempting
to connect to the local SMH (https://localhost:2381) fails with a Page
cannot be displayed error.

Servers All Integrity
Workaround Configure Internet Explorer to bypass the proxy server for local addresses as

follows:
1. In Internet Explorer, click Tools > Internet Options.
2. Click the Connections tab.
3. Click LAN Settings.
4. UnderProxy Server, select theBypass proxy server for local addresses

checkbox.
Another solution is to use https://127.0.0.1:2381 instead of
https://localhost:2381.

Program terminates after error message
Issue If SMH is frequently installed and then uninstalled, or if the SMH service is

frequently stopped and then started again, the following error can be written
to the Windows application event log:
Faulting application smhstart.exe, version 2.0.0.103, 
faulting module unknown, version 0.0.0.0, fault address 0x00000000

Servers All Integrity
Workaround In most cases, SMH still works normally even after this message appears.

However, in rare cases when SMH terminates after this message, you should
uninstall SMH, remove the%Windisk%\hp\hpsmh folder, and reinstall SMH.

Incorrect number of CPUs displayed in System Report
Issue In the Cell Board Information section of the SMH System Report page, Number

of CPUs in Cell refers to logical CPUs. In the Partition Information section,
Total Number of Active CPUs also refers to logical CPUs. Physical CPUs
are displayed in the Processor Details section. The Processor Details section of
the SMHSystemReportmight not reflect the actual number of CPUs recognized
and used by the operating system.

Servers All Integrity
Workaround View the correct CPU information in the Operating System section of the

Processor Utilization page.
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Version Control

VCRM unsupported components
Issue VCRM does not support the following components:

• HP Integrity Gigabit NC370 Series driver for Windows Server 2003 on
Itanium-based systems

• Win/Linux 133MHz 10 Gbe SR Fiber Adapter Driver
• HP Integrity Gigabit Ethernet Dual-Port NIC Driver
• OpenSSH Services for HP Systems Insight Manager
• HP StorageWorks Fibre Channel Adapter Kit for the QLAxxxx STORPort

Driver for Windows Server 2003 on Itanium-based systems
• HP StorageWorks FC-HBAConfigurationUtilities byQLogic forWindows

Server 2003 Itanium-based systems.

Servers All Integrity
Workaround There is no workaround at this time.

VCRM fails to start
Issue VCRM fails to start if SMH is uninstalled, the system rebooted, and then SMH

is reinstalled. This problem occurs only when the system is rebooted between
the SMH install and reinstall.

Servers All Integrity
Workaround Reinstall VCRM after reinstalling SMH.

VCRM updates wrong support pack
Issue VCRMuploads the English Support Pack instead of the Japanese Support Pack

when used on a Japanese operating system.
Servers All Integrity
Workaround Before uploading the Support Pack on a Japanese operating system, change the

browser's language setting to “en” or “en-us”, upload the Japanese Support
Pack, and then switch the browser's language setting back to Japanese.

Inaccurate VGA information displayed
Issue Version Control displays the VGA driver installed version and latest version

on HPVM guests, even though VGA is not supported. There is no VGA on
HPVM guests, however, the driver shows up in version control. The driver is
loaded when Windows incorrectly detects VGA and installs the driver. The
foundation agent passes the information to version control, and version control
displays the driver installed version, Support Pack version and latest version.

Servers HPVM guest
Workaround Ignore the message, there is no negative impact from the video driver. There is

currently no work around.

Video

Video not displayed
Issue After installingWindows Server 2003 or setting up the system for the first time,

there is no video display.
Servers All Integrity
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Workaround Follow these steps:
1. Connect remotely to the system and open the device manager. See if the

display adapter has started without any problems.
2. If no problems are reported for the display monitor, verify all cables are

properly connected.
3. If you are using a KVM or LCD monitor, the resolution, refresh rate, or

both may be set too high for the monitor. Verify this is the problem by
connecting a CRT monitor. If the CRT monitor works you will need to
lower either the resolution, refresh rate, or both to use the KVM or LCD
monitor. Check the monitor specifications for the maximum settings.

vKVM and vMedia

Tool bar fails to redraw as expected
Issue The vKVM window tool bar sometimes fails to redraw completely after other

windows have been open on the screen.
Servers rx6600, rx3600, rx2660
Workaround Move the mouse to the toolbar area, and the tool bar becomes visible.

vMedia drive not immediately accessible
Issue When using vMedia to connect client media (physical of ISO) to RUSA, there

may be a delay before that vMedia drive is accessible from File Explorer on the
RUSA system. This delay is typically a few minutes.

Servers rx6600, rx3600, rx2660
Workaround There is no workaround at this time.

vKVM session stops updating
Issue The vKVM session stops updating in the middle of a Windows install from the

Microsoft RTM media when a monitor is connected to the VGA port of the
server.

Servers rx6600, rx3600
Workaround Perform the installation from the RTMmedia without the monitor connected.

This issue can be prevented by ensuring that the server vBIOS version is BK-ATI
VER008.004.037.101.
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2 Installing Windows Server 2003
This chapter provides an overview of the Windows Server 2003 installation on HP Integrity
servers using the HP Smart Setup CD and your licensed copy of Windows Server 2003. It is
intended for system administrators with experience performingWindows installations. A more
detailed description of the installation process is in the Smart Setup Guide located on theHP Smart
Setup CD.
The operating system can be installed from either a GUI or headless console. Installing from
either console involves preparing the server, booting from the HP Smart Setup CD, running
EBSU, launching Windows Setup, loading operating system files to the boot disk, and booting
the server from the boot disk.

NOTE: Windows Server 2003 can be installed using vKVM on the rx2660, rx3600, and rx6600
servers. For detailed instructions, see the Smart Setup Guide on the HP Smart Setup CD.

Preinstallation Tasks
Before you begin the operating system installation on your HP Integrity Server, complete these
tasks:
• Select whether to install from a headless or GUI console
• Back up existing data
• Locate the Microsoft Certificate of Authenticity
• Set up a headless or GUI console
• Set up PXE/Remote Installation Services (RIS) or Windows Deployment Services (This step

is necessary only if you are using a RIS server as part of your deployment.)
— Set up a RIS server
— Install RIS
— Configure RIS
— Authorize a RIS server in Active Directory

NOTE: Windows Deployment Services is the updated version of RIS included with
Windows Server 2003 SP2.

• Prepare the server hardware:
— Set up the boot drive: Disconnect all mass storage devices from all controllers except

the boot controller. HP recommends installing the boot controller in the root cell.
— Locate the DVD/CD drive.
— Set ACPI flag to windows (cell-based servers only).
— Specify NIC for a network boot.

Installation Tasks
Boot the server with the HP Smart Setup CD in the CD-ROM drive. The server boots to the
EFI-Based SetupUtility (EBSU). EBSUprovides an Express Setup utility to helpwith configuration
tasks such as creating hard disk partitions and updating the firmware. During Express Setup
you are prompted to insert your licensed Windows Server 2003 CD.
1. Install from a headless or GUI console

a. Run EBSU
b. Run Windows Setup
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2. If you choose to install from aGUI console you are prompted to specify server settingswhen
the Windows setup is complete.

Reinstallation Tasks
If yourHP Integrity serverwas purchasedwith a factory-installed operating system,HP provides
anHPReinstallationCD,which allows you to restore the server to its factory condition if necessary.
Use this CD to perform the reinstallation.
• Reinstall from a headless console

— Load the system image
— Specify server settings

• Reinstall from a GUI console
— Load the system image
— Specify server settings

Post-Installation Tasks
Perform the following tasks in the order shown. The operating system must be installed before
performing these tasks :
1. Apply the operating system and security updates from the HP Smart Update DVD.
2. Install the HP Support Pack from the HP Smart Setup CD to update firmware and device

drivers.
3. Install updates from the HP website.
4. Enable Windows Components.

a. Install TCP/IP.
b. Install SNMP.
c. Configure SNMP.

5. Install Management Tools.
a. Install Partition Management tools.
b. Install System Management Homepage.
c. Install Management Agents.

Tips and Tricks
The following tips enable you to overcome some issues you might encounter while deploying
your Integrity server.
• Install Service Pack 2

This upgrade is necessary for Intel Dual Core Itanium processor support.

• Enable hyper-threading on Integrity servers
The default setting for hyper-threading is off. To enable hyper-threading, go to the EFI shell
and enter cpuconfig threads on. To disable hyper-threading, go to the EFI shell and
enter cpuconfig threads off.

• Enable remote desktop connection from a headless server
The remote administration mode is enabled by default on Windows Server 2003 if you are
using the operating system supplied as part of the HP reinstall media. If you are installing
or reinstalling using Microsoft RTM media, the Remote Desktop functionality is disabled.
To enable remote desktop connections, go to the SAC prompt and enter:
reg add “HKLM\System\CurrentControlSet\Control\Terminal Server” /v
fDenyTSConnections /t REG_DWORD /d 0 /f
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• Enable greater than 256 interrupts (cell-based servers only)
When usingWindows Server 2003 on cell-based servers, the system on allows 256 interrupts.
To overcome this limitation, apply QFE 900713, then add /EXTINTVEC to the boot options
using NVRBOOT.

• Disconnect all drives except the boot drive prior to OS installation
Only the target operating systemdrive should be connected during installation. This ensures
that the operating system is installed on the correct drive. Make sure that the Z: drive letter
is free. Windows Server 2003 with SP1 creates the EFI partition here. HP recommends that
you install the boot controller in the root cell.

• Default MP/iLO settings for cell-based and entry-level servers
For cell-based servers, the MP is assigned a static IP address at the factory before it ships. It
is not assigned a DNS name and it is not DHCP enabled. If you are performing a headless
server installation, you can connect to the MP over a LAN (instead of using a serial cable)
by using this static IP for initial configuration of theMP. The default IP address of a cell-based
server’s MP is 192.168.1.1. The default user name and password are Admin and Admin.
Change the IP address and the default password at installation.
For entry-level servers with iLOMPs, the MP is assigned a default DNS name at the factory
and is DHCP enabled. It is not assigned a default IP address. The default host name can be
deduced from the MP's MAC address. The host name is in the form mpMAC, where MAC is
the 12-digit MAC code of the MP's NIC. The MAC address of the MP LAN interface is
typically located on a sticker on the back of the server.

• Set Cell Local Memory to 100% (cell-based servers only)
HP recommends that you set the Cell Local Memory (CLM) parameter to 100% for optimal
server performance.

• Loading OEM boot drivers
Boot drivers can only be installed from the Windows installation CD or a floppy disk.
Integrity servers do not have floppy drives, so boot drivers that are not on theWindows CD
must be loaded intomemory and then installed. EBSU shows devices that it detects and that
have a virtual floppy image available. To load the driver:
1. Boot the server. Load the HP Smart Setup CD into the server CD-ROM/DVD drive.
2. From the EFI Boot Menu, select Internal Bootable DVD and press the Enter key.
3. From themainmenu, selectLoad OEM Boot Driver andpress theEnter key to continue.
4. Select the boot controller driver to place on the virtual floppy for use during Windows

installation. Select OK, and press the Enter key.
• Using F8 from a headless console

Pressing the F8 key when using a headless console does not work.When prompted to press
the F8 key, you must press the Esc 8 key sequence instead. Press the 8 key within two
seconds after pressing the Esc key. Otherwise, the system registers only the Esc key and
reboots.
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3 Product Support
This chapter points you to documentation to help you work with Microsoft Windows Server
2003 on HP Integrity servers and to obtain the system firmware, drivers, and utilities applicable
to Windows Server 2003.

Technical Documentation
Technical documentation for HP Integrity servers running Windows Server 2003 includes the
followingmanuals in English and Japanese. These manuals are available on the HP Smart Setup
CD and from the HP Integrity support Web site: http://www.hp.com/support/itaniumservers/.
Smart Setup Guide Provides instructions for installing, reinstalling, or

migrating toWindows Server 2003 onHP Integrity servers.
Headless Installation white paper Provides a discussion of the benefits of installing,

configuring, andmanagingWindows-on-Integrity systems
in a “headless” fashion, usually remotely, andwithout the
need for a monitor, keyboard, or mouse being directly
attached to the server.

nPartition Guide Provides instructions for creating, configuring, and
managing nPartitions on cell-based HP Integrity servers
running Windows Server 2003.

Support Pack andDeployment Utilities
User Guide

Provides instructions for using the deployment utility and
setup tools to perform routine softwaremaintenance tasks
in Windows Server 2003 64-bit server environments.

Cluster Installation and Configuration
Guide

Provides instructions for configuring your Integrity server
as a node in a cluster. Clusters consist of multiple nodes
but appear as a single, virtual server to the outside world.
They help to eliminate unplanned system downtime by
providing hardware and software redundancy.

Boot from SAN Guide Provides instructions for booting your server froma storage
area network (SAN) instead of internal SCSI and IDE
storage devices. Booting from an external SAN decreases
downtime through faster server replacement in the event
of a server failure.

SmartSetup Scripting Toolkit
Deployment Guide

Provides instructions for using the SmartSetup Scripting
Toolkit (SSTK) to perform automated replication of a
server’s hardware configuration and attached storage array
controllers. The SSTK also ties into standard, unattended
installation processes for the Windows operating system
and applications.
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Technical Support
To keep your server up to datewith the latest firmware, drivers, and utilities, visit theHP technical
support web site periodically.

Get Windows-specific firmware, drivers, and utilities
To obtain the system firmware, drivers, and utilities applicable to Windows Server 2003:
1. Go to http://www.hp.com/.
2. Click Software & Driver Downloads.
3. On the Software & Driver Downloads page, select Download drivers and software (and

firmware) and enter your server model name or number in the search field. Click Begin
Search.

4. On the Product Search Results page, refine your search further by clicking your exact server
description from the list presented.

5. In theDownloadDrivers and Software page, selectMicrosoft Windows Server 2003 64-bit
Edition as your operating system.

6. In the next Download Drivers and Software page, download the desired drivers by clicking
the drivers.

NOTE: OnlyHPCEs are authorized to update the system firmware onHP Integrity rx7600-series,
rx8600-series, and Superdome servers. Contact HP Support for updates to the firmware.

Register for HP support notifications
HP recommends that you register for alerts and notifications to stay informed of updates to the
drivers, patches, and other components specific to your server.
Go to http://www.hp.com/united-states/subscribe/gateway/.
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